RES (Radio Editing Software) Release Notes
Version 5.8.28 (06/22/23)
Features:

Add BKR9600 mic AGC enable and gain level options
Change BKR900O internal mic select default to automatic

Version 5.8.27 (05/16/23)
Features:

Add internal mic select for BKR9000

Version 5.8.26 (05/04/23)
Features:

Add LLA Keys Manager tool

Hide man down panel if no man down switch in radio

Adding internal and external mic gains

Add maximum volume setting
Change function button name from RSM Speaker Attenuation to Speaker Attenuation

Version 5.8.24 (02/05/23)
Features:

Expand BKR9900 700/800MHz Band Tx Frequency Range

Add encryption level provisioning in FES

Add Wi-Fi enable in FES
Add noise cancellation in FES

Version 5.8.21 (05/19/22)
Features:

Expand developer mode allowed email extensions



Version 5.8.20 (03/09/22)
Fixes:

Fix the new project wizard causing a crash

Version 5.8.19 (03/04/22)
Features:

Add ability hide columns in the multi channel view

Fixes:

Fix writing codeplug to mobile radio through a control head
Fix code guard combo box text editor

Version 5.8.18 (01/18/22)
Features:
Fixes:

Fix crash when opening new project wizard

Version 5.8.17 (01/06/22)
Features:

Use the host system's locale decimal separator in numerical fields

Fixes:

Upgrade log4j version to 2.17.1 to avoid moderate level Log4Shell vulnerabilities

Version 5.8.16 (12/15/21)
Features:
Fixes:

Upgrade log4j version to 2.16.0 to avoid the Log4Shell vulnerability



Version 5.8.15 (11/2/21)
Features:

Add support for version 2 of the RSM accessory
Add support for all band radio type

Fixes:

Fix emergency hot mic selection logic
Remove requirement that MSB of ESN is ©x10
Remove call alert reset time

Remove keypad mute function

Remove evacuation tone sequence

Version 5.8.14 (3/19/21)
Features:
Fixes:

Allow GPS Peer Location on top display

Allow GPS Peer Location to include an alternate display option on the main display
Force GPS Peer Coordinates to the main display option and disable the alternate
when selected

Use 'Selectable' as a Unit Call Encryption selection instead of 'Use Channel
Setting’

Allow only one system priority to use the main channel

Allow only one priority to use the main channel in the Zone Settings

Version 5.8.13 (3/3/21)
Features:

Added voice announcement priority global parameter.

Added scan list global conventional button to allow editing scan settings of all
conventional channels.

Added scan list option to conventional menu items.

Added scan list option to conventional programmable buttons.

Fixes:

Removed the GPS display options from the top-display choices.



Disabled alternate display option if a GPS display option is selected on a main
display line.

Version 5.8.12 (2/16/21)
Features:

Allow all valid DTMF tone entries (i.e., ©-9, A-D, * and #) where applicable
Fixes:

Hide off-hook mute all global parameter if non-mobile radio is selected

Fix bug causing Zone Clone to fail whereby the dialog would never appear
Fix bug of TX High and Low Power settings not retaining selected value

Version 5.8.11 (1/29/21)
Features:

Fixes:

Allow a 6 character number to be entered for a two tone frequency

Remove top alias from parameters

Allow all display options for the top display
Add voice announcement gain global parameter

Version 5.8.10 (1/18/21)
Features:

Provide initial support for the BKR-9000 multi-band radio.

Fixes:

Fix hidden confirm dialog for zone clone window.

Ensure proper validation of CxCSS entries after editing is finished on conventional
channels in the multi-channel view.

Version 5.8.9 (11/30/20)

Features:



The batch programming RSI fields behave more like the RES RSI fields (e.g., "N/A"
displayed when values are out of range, etc.).

The batch programming log now displays "N/A" if the RSI value is out of range.

The batch programming dialog now displays the current parameter file correctly in a
separate field; it has been removed from the title bar.

The OTAP dialog now displays the current parameter file correctly in a separate
field; it has been removed from the title bar.

Fixes:

Ensure proper validation of CxCSS entries after editing is finished on conventional
channels in the single-channel view.

Always default the BKR-5000 channel collar switch to perform zone-select after a
file load to improve reading older .neo files.

Removed "Automatic" selection from the trunking system Tx power type as the radio
firmware does not support RSSI-based power changes.

Corrected a bug whereby various pop-up windows (e.g., batch programming) could

access unallocated memory thereby resulting in a crash.
The batch programming RSI ID is validated before and after auto-increment.

Version 5.8.8 (10/8/20)
Features:

Fixes:

Provide detailed message of possible file-lock when opening a RES file in Batch
Programming.

Fix logic preventing OTAR data from being read from a radio.
Fix maximum limits on RSI text boxes.

Version 5.8.7 (7/22/20)
Features:
Fixes:

Check RSI and Message Data fields for invalid values -- display "N/A" accordingly.

Version 5.8.6 (6/26/20)
Features:

Add Top Display Text to keypad lockout options for BKR-5000; it should hide/show



based on radio-type selection.
Limit top display options to ones that will fit for BKR-5000: Channel Label,
Channel Number, Zone Number + Channel Number, and Zone Number.

Fixes:

Correct Excel export preferred site number: in both Announcement-Groups and
Talk-Groups the preferred site list number was not correctly showing "None" for
index ©.

Change Excel importing of Announcement-Groups to behave like Talk-Groups whereby
"None" is now case-insensitive, and © is correctly assigned in the event none is
imported.

Version 5.8.5 (5/14/20)
Features:
Fixes:

Use default RES preference file if existing one is not readable
Excel Import Wizard: process zone sheets when no pick lists are selected

Version 5.8.4 (4/24/20)

ANNOUNCEMENTS::

This release is the result of combining features and fixes introduced in the
5.6.x version of RES into that of the 5.8.3 version that were previously

not included. It is meant to be the single version of RES used to program
all products moving forward.

Features:

Update firmware and parameters version limits: minimum firmware read/write version
= 5.5.0, maximum parameter file version = 5.6
- firmware version can be overcome via options->firmware restriction menu
option
Added in the enhance scan with zone parameter
Warn user that USB keys are not supported on Linux
Updates the Global->Conventional panel in RES
Automatically focuses on search text when tabbing away and coming back
Adds GPS Pre Tx Trigger to RES
Adds GPS Impolite
Removes MSAT from trunking main menu
Log all excel import values that aren't found and warn the user
Remove External Radio



Adds SNDCP Deregistration to Excel Import

Adds Code Plug Version to global parameters

Removed 'Quick Status' from menu search

Changed 'Selectable' to 'Use Channel Setting' for unit call encryption selection
Recent file list updated to allow ',' in filename

Adds support for specific searches in Parameter search using quotation marks
(single or double)

Alphabetize display line selections

Deprecated Mobile I/0 enable parameters

Added prompt to warn users who program Auto Keypad PTT that this will override
programmed keypad functions

Enable Auto-keypad PTT if Global DTMF Live Dial is enabled

Adds Trunking SNDCP Deregistration Parameter

Changed logic to look at all systems, not just current system, for search

Move top display line into the display panel

Multi channel view how displays channel label and index on upper right portion of
table to help user better navigate and use the multi channel view

Added auto-save feature to batch programming for log files

Systems are no longer allowed to be moved up/down

Upon update, users are prompted with the changes made in this version. The help
menu has also been reorganized for better access

Batch Programming now sets title based on codeplug opened

Batch Programming now gets a copy of the parms RES has opened

Added File Lock to neo files to prevent other apps from modifying them while opened
Removes 'TX Inhibit' from search and from button options

Added 4,6,8,10,12 hour time intervals to mobile power down.

Added Mobile Display Disabler application

Added Mobile I/0 Call Alert Feature

AHS Handset Offhook Mute All

You can now use the 'del' key to delete table entries

Neo files can now be dragged and dropped to open

Added new GC parameter: Ignore transmissions from own UID

Added global DTMF Live Dial

Moved all windows under the 'tools' panel. Renamed 'tools' panel to 'utilities'
Global Default Squelch added & Conventional Channel Squelch exposed to user

Add support for AES keys

Added offhook talkback to GC

Added in evacuation tone feature to both menu and buttons for conventional only

Fixes:

Fixed read issue with OTAP

Fixed highlight color of table rows

Pop-up messages now show up in front

Various internal updates

Fixed channel parms being set before picklist imported

Changed name of 'OTAR Channel' to OTAR/Data Channel'’

Do not not error out if unable to write the preference file
Channel comboboxes now update properly

Hide GPS distance change and GPS host request until implemented



Autosave history window always on top blocked warnings and other windows and does
not appear to be necessary

Do not force an update for channel view selection

Fixes bug where RES wouldn't let you reopen an open file

Changed Window to Utilities for auto save history error

Changed Versions Manager to Version Info String for window

Updated RES Icon

Batch Programming now ends connection threads when closed

Baud rate now reads/writes properly

Do not show duplicate errors per zone

Removed Mobile I/0 enables from search (deprecated)

Better handling of null strings

Try to prevent the registration window from popping up on read failure
Updates searched menu items so that they go with their respective radio types
Fixes read radio bug where RES would not receive current parameter
Disable RSM emergency flash LED checkbox if P25 system is Rx only
Fixes key index changing bug

Fixes poor wording of Soft Power Down Timer

Round frequencies to 1.25 kHz multiples

Moving channels multiple spaces fixed

Minor tweaks to contact software support email

Tone Remote Interface is now mobile only

Fixed caret placement

Remove auto-Jira ticket generation

Switching views now selects the proper channel on any zone

Talkgroup is now selectable in multi-channel view

Enable write attribute before attempting to open file

Fixed issue with opening a file after saving

Conv Encryption keys menu and softkeys don't match

Fixed error being thrown when reading from Batch Programming

Fixed sizing of RS485BaudChanger

RX only trunking system additional options not disabled

Zone clone multiple zone window does not open.

Remove Mahi and Wahoo radio types and multiband option

Fixes Baud Rate Changer allowing baud rate to be changed on portables
Fixed UI for Mobile ignition low timer

Fixed programmable buttons

Fixed searchable parameters

Fixes to ensure additional ignition timer values are valid

Fixed barcode scanning issue

Changes to accomodate new ignition line lower timer in RES. Search/excel added.
BRP would not increment radio name if no digit was at the end

Added missing parameters to Excel import

CParametersCC now limits frequencies properly for 700/800 band

Fixed frequency updating issue

Version 5.8.3 (4/2/20)



Features:

Added in dedicated zone/channel for GPS data

Adds Daylight Savings time parameter

Added date and time source and date and time manual override parameters
Fixes:

Added in missing search parameters

Moved Time Zone selection into date & time panel
Remove GPS lines from top-display combo boxes

Version 5.8.2 (3/22/20)
Features:

Add GPS Peer Coordinates to the conventional and trunking display options
Added support that allows the user to enable / disable GPS

Version 5.8.1 (2/23/20)
Features:

Add keypad mute to menus and buttons

Fixes:

Add top-label to multi-channel view table

Show/hide the top-display parameters in multi-channel view

Adding top-label to Excel import parameters
Fix bug not allowing Enhance Scan with Zone Scan to update correctly

Version 5.8.0-rc9 (2/5/20)
Features:

Add quick status button choices

Add voice annunciation mute to menus and buttons

Add Top Alias to conventional and trunking channels

Fixes:

Make top display default to channel label instead of none
Correctly set channel collar to zone-select



Version 5.8.0-rc8 (12/27/19)
Features:

Added Volume Adjust Tone

Version 5.8.0-rc7 (12/9/19)
Features:

Enhance Scan: add zone scan to enhance scan and toggle switches

Version 5.8.0-rc6 (11/22/19)
Fixes:
Fix Top Display configuration on trunking channels

Disable FES checkboxes and radio buttons when it is opened from inside RES
Remove Top Display Bottom Line Support

Version 5.8.0-rc5 (11/4/19)
Features:

Add RSM related conventional/P25 Trunking Main menus
Add BKR5000 RSM programmable buttons

Version 5.8.0-rc4 (10/23/19)
Fixes:

Consolidate Codeplug parameters

Version 5.8.0-rc3 (10/11/19)

Features:



Add flip top-display option for BKR-5000

Fixes:

Allow open Baud Changes

Consolidate Codeplug parameters

Remove ability to program Bluetooth to buttons/menus on BKR-5000 (no hardware

support)
Add physical unit to the Soft Power Down Timer Label

Version 5.8.0-rc2 (9/16/19)
Fixes:

Assign channel collar Zone Select for BKR-5000

Version 5.8.0-rcl (9/13/19)
Fixes:

Reassign internal Radio Id enumerations

Version 5.8.0-rc@ (9/12/19)

Features:

Support for Radios BKR-5000

Version 5.5.9 (6/27/19)

ANNOUNCEMENTS::

As of April 8, 2014 Microsoft stopped supporting Windows XP and therefore
it is no longer an officially supported platform. Users may still continue
to use RES on Windows XP at their own risk, but we can no longer provide
complete guarantees for RES on Windows XP, since the 0S is no longer being
updated by Microsoft.

Features:

Allow users to read / write from any firmware version
Allow RES 5.5 to read encrypted preferences from 5.6



Remove auto-update feature
Fixes:

Fixed rounding of non-standard frequency values assigned to control channels.
Fixed default Zone toggle to Zone 1 (instead of Zone 2)
Fixed Exception when attempting to open 5.6 codeplug

Version 5.5.3 (11/10/17)

ANNOUNCEMENTS :

As of April 8, 2014 Microsoft stopped supporting Windows XP and therefore
it is no longer an officially supported platform. Users may still continue
to use RES on Windows XP at their own risk, but we can no longer provide
complete guarantees for RES on Windows XP, since the 0S is no longer being
updated by Microsoft.

v

Features:

Lightning Light driver is now installed when RES is installed

Exporting in Audio Converter automatically sets the Voice Annunciation directory in
RES

Batch Programming can now change the radio type

Batch Programming can now save codeplugs with either the ESN or serial number
Multiple rows are now selectable in Multi-Channel view by using shift-click or
ctrl-click

All tables now allow users to move entries up and down using ctrl-up, ctrl-down or
the right-click menu.

Added ability to close a codeplug without closing RES

Fixes:

Fixed issue where double-clicking to open a .neo file did not update the radio type
Fixed issue where RES would not warn the user if they attempt to save a file that
is open in another program

Extended Channel ID Tx Offset entries to take 5 decimal places instead of 3

Fixed issue where Batch Programming would lock up when trying to use a radio name
of all numbers

Removed various menu/buttons that are not programmable on certain radio types
Fixed issue where importing Excel file with extremely long labels would not work
Fixed issue where an exported Excel sheet with Trunking channels could not be
re-imported

Fixed Graphical issue where Batch Programming log colors would not reset

Version 5.5.2 (7/6/17)



Features:

Added Child Key Maker (Window -> Child ASK Maker)

Added option to turn off the Auto-update check (Options -> Check for update on
startup)

Added Text-To-Speech capabilities in Audio Converter / Voice Annunciation

Added feature to set all systems & RSI to the same value (tools -> Set Global Radio
ID...)

PC Access password now restricts write

All parameters are now searchable (accessible through keyboard shortcut "ctrl+F")
Reworked excel import / export to dynamically find columns to make future excel
exports backwards compatible

ASK Implementation for Hardnened computers

Fixes:

ESN now loads properly when opening a .neo file via double-click

KNG2 codeplugs are now saved/loaded as KNG2 (not KNG) codeplugs

Fixed auto-save functionality with newer codeplugs

Fixed display issue with changing zone indexes

Copy/paste directly from excel into text fields now works properly

Trunking Channel Identifier Base Frequencies can now be set outside of the band
restrictions

Fixed issue where Software encryption keys were not editable until key data was
entered

Fixed issue where RSI values were not displayed properly

File choosers & Warning messages can no longer be clicked past

Fixed issue where Batch Programming was logging incorrect values while performing
Express Programming

Fixed issue where in some cases the receive codeguard would change to the transmit
code guard randomly

Various fixes with Dual Mode Scan table

Various fixes with 'save as...' functionality

Version 5.5.1 (4/6/17)
Features:

Ability to open multiple instances of RES to compare/edit multiple code plugs at
once

Zone Clone can now chose where the zone will be cloned to on the destination radio
Crypto Variable entries are now viewable until submitted to the table

RSI values are now saved within the .neo file

All Zone settings are now in a separate window to provide more space for
multi-channel view

Expanded Audio Converter support to multiple .wav formats



Ability to copy/paste multiple channels across zones (and on multi-channel table)
Ability to type in the Trunking Talkgroup you wish to set on Trunking Channels
Added Recently opened file list (located in File -> Recent)

Excel Export/Import of Channels now assigns a system number to each channel
Updated Audio Converter help document

ESN is now saved with every code plug (instead of only with code plugs that have
trunking systems)

Excel Import now handles both decimal & hexadecimal values for Trunking System
Talkgroups

Updates & Improvements to Search feature

Developer Mode now allows disabling of Trunking System Receive Only parameter
Adding log clearing functionality to Batch Programming

Screens with resolution down to 1200x900 are now supported

Added Audit information, which includes last written System key, date, time, etc.

Fixes:

Fixed System ID not showing in Trunking System Sites Table

Fixed issue with setting conventional channel frequencies in Multi-Channel View
You can now paste channels into empty zones

Fixed Bug where Excel import of trunking channels did not accept blank cells

Fixed issue where Batch Programming would lock up with USB System Keys

Improved performance with codeplugs containing large scan lists

Various UI Improvements

Low/High Power for conventional systems are now defaulted properly based on band
setting

Fixed rare issue where RES would ask to register again

Fixed rare issue where selecting a column in multi-channel view caused the table to
scroll

Fixed issue where programmable buttons could not be viewed properly in NeoVision
Fixed rare issue where Batch Programming would write duplicate system list entries
Fixed password-restricted USB keys not being able to be opened

Fixed issue with non-consecutive channels in multi-channel view

Version 5.5.0 (1/25/17)
Inital version release

Added Batch Programming Application

Added Audio Converter Application

Name change from Radio Options Control to Feature Editing Software

Added all necessary parameters for firmware 5.5.0

This version is compatiable with firmware 5.5.0.

Open code-plugs (.neo files) that are 5.0.0 or newer, you can still open older
code-plugs but parameters may not be converted correctly.

Read radios that are 5.0.0 or newer ONLY

Write to radios with firmware versions 5.5.0 ONLY

Converters code-plugs that are 5.0.0 or newer to 5.5.0



